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Glossary

Accelerator key A  ftertouch  A  pplication  

A  pplication icon  A  uto Rewind  B  eat  

C  ancel  C  hannel  C  heck box  

C  heck mark  C  lef  C  lick  

C  lick and drag  C  lipboard  C  ombo box  

C  ontrol  C  ontroller  C  opy  

C  ursor  C  ut  D  efault  

D  ialog box  D  irection keys  D  ouble-click  

D  rop-down combo box  D  rop-down list  D  rop-down menu  

F  ield  F  unction key  G  roup box  

H  ighlight  I  con  I  RQ or Interrupt  

I  tem  L  ead-in measures  L  ist box  

M  enu  M  enu bar  M  etronome  

M  IDI  M  ouse button  M  ultiple selection  

O  K  P  aste  P  atch  

P  itch Bend  P  ointing device  P  rogram Change  

P  rompt  P  ushbutton  Q  uantize  

Q  uit  R  adio button  R  eal-time recording  

S  croll  S  croll bar  S  election  

S  equencer  S  ingle-click  S  tandard MIDI File  

S  tep Record  S  tudio file  S  ystem Exclusive  

T  ab  T  ext entry field  T  ick  

T  itle bar  T  rack  U  ser interface  

V  elocity  V  iew  W  indow  



Accelerator key.

(Windows term) A key or combination of keys that 
invokes a function or command. See also Function 
key.



Aftertouch.

(MIDI term) Pressure applied to the keys of a MIDI 
keyboard after they are depressed. Some MIDI 
keyboards send this special information, although many 
devices do not respond to aftertouch. There are two 
types of aftertouch: key, or polyphonic aftertouch (each 
key sends out aftertouch independently), and channel 
aftertouch (all keys send out the same message).



Application.

A synonym for computer 
program.



Application icon.

(Windows term) A special icon (picture) that represents 
an application, or program, when minimized. See Icon.



Auto Rewind.

A feature that returns the location Counter of the 
song to where you started (not necessarily the 
beginning), when you stop recording or playback.



Beat.

A unit of time in music. In Session, a beat 
represents a single metronome click, and is 
equivalent to a quarter note (or 96 ticks).



Cancel.

(Windows term) A standard dialog box 
pushbutton. Cancel closes the active dialog box 
without taking any action. This is equivalent to 
pressing the Esc key on the computer keyboard. 
Contrast with OK.



Channel.

(MIDI term) The MIDI standard allows 16 MIDI 
channels. Each channel can potentially be 
assigned to a different MIDI instrument - the MIDI 
instruments each know which channel(s) to 
recognize and which to ignore.



Check box.

(Windows term) A common Windows control, the 
check box is a square box next to text or a picture, 
indicating a user choice. This control acts like a switch. 
When the check box is switched on, an 'x' appears in 
the box. Any number of check boxes in a group can be 
active at one time. See Radio button.



Check mark.

(Windows term) A mark that appears next to a menu item 
when the item is active. This is used only for items that 
switch on and off.



Clef.

In musical notation, a symbol that indicates the pitch range of 
a staff. A treble clef indicates a high range; a bass clef 
indicates a low one.



Click.

To press and release a button on the mouse, while the mouse 
pointer is positioned on an object. See also Click and drag and 
Double-click.



Click and drag.

To press and hold down a mouse button, move 
(drag) the mouse to a different location, and then 
release the mouse button. This technique is used to 
select an area or range. See also Double-click.



Studio Clipboard.

A temporary area to which you can copy data, and 
from which you can retrieve data. The Cut and Copy 
commands place selected music into the Studio 
Clipboard, and the Paste command retrieves music 
for placement into a song. This is similar, but not 
identical, to the Windows Clipboard.



Combo box.

(Windows term) A Windows control that is a 
combination of a list box and a text entry field. See List 
box and Text entry field.



Control.

(Windows term) A Windows object that allows you to 
interact with a program, making choices and entering 
information. Examples of controls are radio buttons, 
check boxes, list boxes, and text entry fields.



Controller.

(MIDI term) A device used to output MIDI 
messages (e.g. wind controller).



Copy.

An Edit menu command that duplicates a selected 
note (or group of notes) and retains a copy in 
memory for further use. The selection is 
unchanged. Contrast with Cut.



Cursor.

(Windows term) A position indicator in Windows programs. The 
default cursor is shaped like an arrow or pointer, and is moved 
around with a mouse or keyboard. When the cursor is over a 
menu item or other object, you can select the item or object. 
Cursors often have different shapes, depending on modes of 
operation. For example, in Session the cursor changes into a 
note shape when you have selected the Note Add Tool.



Cut.

An Edit menu command that duplicates a selected 
note (or group of notes) and retains a copy in 
memory for further use. The selection is removed. 
Contrast with Copy.



Default.

A number, word or setting that a program assumes without 
the user giving an answer. Many parts of Session make 
assumptions to make the product easier to use. For 
example, when using the RECORD button, the default 
destination track is the first unused (clean) track.



Dialog box.

(Windows term) A window type, allowing the user to 
enter information necessary to the operation of a 
program. A box appears on the screen and the computer 
expects a response from the user. A dialog box is 
completed when you click a pushbutton labeled with 
some action, such as OK or Cancel.



Direction keys.

The four keys (up-arrow, down-arrow, left-arrow, right-
arrow) on the computer keyboard which move the cursor 
around on the screen.



Double-click.

(Windows term) A technique of pressing down a 
mouse button twice in rapid succession, without 
moving the mouse. This is usually used to start an 
application from an icon. Compare with Click and 
Click and drag.



Drop-down combo box.

(Windows term) A type of combo box in which a list 
remains hidden until you click on the arrow to the 
right of the box. The list then "drops down." See 
Combo box.



Drop-down list.

(Windows term) A type of list box in which a list 
remains hidden until you click on the arrow to the 
right of the box. The list then "drops down." See List 
box.



Drop-down menu.

(Windows term) A type of menu that remains hidden until 
you click on the menu title. The complete menu then 
unfolds, or "drops down" so that you may choose a 
menu item. See Menu.



Field.

(Windows term) A non-moveable area on the 
screen used for entry or control of text or 
numbers.



Function key.

One of the special keys across the top or left of the computer 
keyboard. These keys are labeled F1 through F10, or often F1 
through F12.



Group box.

(Windows term) A box that contains related choices grouped 
together.



Highlight.

(Windows term) A selected item on the screen, usually 
shown by reversing the colors of the letters or icon. 
Often items that are selected by moving and clicking the 
mouse become highlighted.



Icon.

(Windows term) A graphical representation (or 
picture). The Toolbox tools in Session are 
examples of icons. A unique icon also represents 
the program when it has been minimized.



IRQ or Interrupt.

IBM PC compatible computers use interrupts to let 
peripherals share the time and resources of the 
computer. Each peripheral (printer, MIDI interface, 
modem, etc.) must be assigned a unique IRQ, or 
interrupt. If two devices are set for the same IRQ, 
the result will be anything from unreliable 
operation to complete failure.



Item.

(Windows term) A choice on a drop-down 
menu. Each menu has a number of items 
that you can select. Items are highlighted by 
placing the mouse cursor over the item, and 
selected with a single click of the left button.



Lead-in measures.

The measures that are counted off by the metronome 
before recording or playing begins. It is often desirable to 
set a few lead-in measures to get used to the 
metronome's timing.



List box.

(Windows term) A Windows control that contains a list of 
choices from which you can select. See Combo box.



Menu.

(Windows term) A list of commands grouped under a 
common title. You choose the command you want by clicking 
on it.



Menu bar.

(Windows term) A place at the top of a window where menus 
are found.



Metronome.

A sound generated upon every 
beat.



MIDI.

Musical Instrument Digital Interface. A language that 
electronic instruments and computers use to 
communicate information about musical performance. 
Session sends and receives messages using the MIDI 
language so that it can talk to any instrument that also 
uses MIDI. MIDI information is typically sent using a 
five-pin round (DIN) connector.



Mouse button.

There are usually two or three buttons on a 
mouse - left and right; or left, middle and 
right.



Multiple selection.

(Windows term) A selection that includes more than one 
object. You can either Shift-click to select multiple 
objects, or click and drag to select a range of objects.



OK.

(Windows term) A standard pushbutton in a dialog box, 
that carries out a command or action and closes the 
dialog box. This is equivalent to pressing the Enter key 
on the computer keyboard. Contrast with Cancel.



Paste.

In Session, to paste a region of music causes music 
starting from the given count to be overwritten on that 
track by the new region of music.



Patch.

Information that a synthesizer uses to define a 
specific sound waveform (timbre). See Program 
Change.



Pitch Bend.

(MIDI term) A MIDI message that controls the 
continuous change of pitch. This often deserves 
special mention because the MIDI language sends 
special signals to communicate the Pitch Bend 
information.



Pointing device.

A device, such as a mouse, trackball, or joystick, which 
is used to move a cursor on a computer screen.



Program Change.

(MIDI term) A MIDI message sent to and from 
instruments that changes the patch or sound information 
for that instrument, resulting in a different timbre.



Prompt.

(Windows term) When a computer program displays a 
query to the user, and provides an action (or actions) to 
take.



Pushbutton.

(Windows term) A rectangular button that is used in a dialog box 
to initiate an immediate action. Common pushbuttons are OK 
and Cancel.



Quantize.

A feature that lengthens or shortens notes (and changes where 
notes begin) to even multiples of a specified note length. Quantizing 
can make somewhat sloppy playing sound tighter, but can also make 
a performance sound too rigid if applied incorrectly.



Quit.

To leave the program. If you have unsaved music or 
edits, you will be prompted to save your work first.



Radio button.

(Windows term) A common Windows control, the radio 
button is a circle next to text or a picture, indicating a user 
choice. This control acts like a switch. When the radio button 
is switched on, the circle appears to be filled. Only one radio 
button in a group can be switched on at any time. See Check 
box.



Real-time recording.

As opposed to Step Recording, lets you play a song and 
keeps track not only of the notes played, but how long 
and when each note was played so that the exact music 
can be reproduced. Audio tape recorders are always real-
time recorders.



Scroll.

(Windows term) To move the display area, causing 
information that is off screen to be displayed.



Scroll bar.

(Windows term) A control that you use to move a window 
or field, to display more information than could be shown 
on the screen.



Selection.

(Windows term) An object or group of objects (text, 
notes, pictures etc.) that you choose. The chosen object 
is highlighted (changes color or intensity) to show it is 
selected. You can make changes to a selection. See 
Multiple selection.



Sequencer.

A MIDI multi-track tape recorder.



Single-click.

Pressing and releasing a mouse button 
once.



Standard MIDI File.

A file format for platform-independent exchange of MIDI sequences. 
Type 0 are single-track files. Type 1 are multi-track files. Type 2 are 
multi-sequence files. Session supports Type 0 and 1 files.



Step Record.

To record one note at a time, giving all the information for individual 
notes. Sometimes used instead of real-time recording, because in 
step recording you need not be able to play perfectly to get perfect 
music.



Studio file.

The native file format of Recording Session. This format 
contains more information than a Standard MIDI File.



System Exclusive Message.

(MIDI term) A special class of MIDI message that allows 
manufacturer-specific information to be received and 
transmitted. Also known as SysEx.



Tab.

(Windows term) The Tab key moves the cursor from one field, 
control, or area to another within a window. You can use the 
Shift-Tab key combination to move backwards.



Text entry field.

(Windows term) An edit control that allows you to enter text and 
numbers. The cursor usually changes into a vertical line or an I-beam 
shape.



Tick.

Music in Recording Session is segmented by Measure, Beat, 
and Tick. There are 96 ticks in each beat.



Title bar.

(Windows term) The area at the top of a window that 
contains the name of the window. When applicable, 
the maximize, minimize and restore icons will also be 
in this area.



Track.

A sequencer term, each voice is displayed on 
the screen and has its own set of music and 
performance features. A voice can be polyphonic 
(many simultaneous notes), but cannot be set to 
more than one MIDI channel.



User interface.

The style and design of the interaction between you and your 
computer. It usually refers to how you select the options you 
want to use or change.



Velocity.

A synthesizer and MIDI term that means how 
hard the key is pressed (or released). For 
keyboards that have velocity control, this can 
affect the loudness or other tonal quality of the 
sound.



View.

Recording Session allows you to select different ways of 
looking at, controlling, and altering your music. These are called 
views.



Window.

An area of the screen with visual 
boundaries through which information is 
displayed.



Menus

This is a reference to all menus and menu items.

Click the mouse on a menu title for help on that menu.



File menu

Click the mouse on a menu item for help on that item.



Edit menu

Click the mouse on a menu item for help on that item.



Options menu

Click the mouse on a menu item for help on that item.



Setup menu

Click the mouse on a menu item for help on that item.



View menu

Click the mouse on a menu item for help on that item.



Track menu

Click the mouse on a menu item for help on that item.



Music menu

Click the mouse on a menu item for help on that item.



Help menu

Click the mouse on a menu item for help on that item.



New

When you want to record a new song, it is a good idea to start with a blank canvas, so to speak. This 
command will clear the memory of any previous data. If you have unsaved changes, you will see a dialog 
box  asking if you want to save them.

The only data that is retained is MIDI events that were previously cut or copied to the Clipboard. This is so 
you can paste a phrase or section of a song into a new song.

Keyboard shortcut: Ctrl+N



Open

This command opens a dialog box  containing a list of song files on disk, the current 
directory, and a text box for typing in a desired filename. You choose the file you wish to open and click 
OK.

The File Name field lets you either type in a song file name, or choose one from the scrolling list box.

The Directories list box lets you navigate through the directories on your disk.

The File Type drop-down list box lets you open either Studio format files or Standard MIDI Files.

The Drives list box displays the current drive and lets you switch to a different drive.

Keyboard shortcut: Ctrl+O



Save

This command saves the song currently in memory to disk. If you have made any changes to a song, the 
changes are saved. If you have not saved the song with a filename yet, you will see the Save As dialog 
box.

Keyboard shortcut: Ctrl+S



Save As

This command opens a dialog box 
 

that is similar to the File|Open command. (Think of it as File|Open in reverse.) Enter a name for the song 
file you wish to save (eight characters maximum). When you click on OK, all of the data you have 
recorded (including any edits) is saved to disk.

The File Name field lets you either type in a song file name, or choose one from the scrolling list box.

The Directories list box lets you navigate through the directories on your disk.

The File Type drop-down list box lets you save your song in either Studio format or Standard MIDI File 
format.

The Drives list box displays the current drive and lets you switch to a different drive.



Exit

This command closes any songs that may be open and quits the program.

Note that you cannot exit when playing or recording.

Keyboard shortcut: Ctrl+X



Undo

This command reverses the last Edit menu operation.

Keyboard shortcut: Alt+Bksp



Select All

This command selects the entire song file for editing/transformation. The selection will remain in effect 
until you make a different selection or until you click within the Score View. Note that you must have 
something selected (score, track, measure, note) to apply an editing operation.

Keyboard shortcut: Ctrl+A



Select Measures

This command opens a dialog box 

. You can specify one or more measures to edit and transform. The selection remains in effect until you 
make a different selection, so you may apply multiple editing operations to the same selection.

You must enter the range of measures to select in the provided edit fields.

The New Selection radio button indicates that this is a fresh selection, regardless of any previous 
selections.

The Add to Selections radio button adds this particular selection to previous measure selections, so that 
you may select multiple measures throughout your song.

 (An example of multiple selections would be Measure 20 to Measure 25 and Measure 32.)



Select Track

This command opens a dialog box 

. You can specify one or more tracks to edit and transform. The selection remains in effect until you make 
a different selection, so you may apply multiple editing operations to the same selection.

Select the desired track from the Track list box.

The New Selection radio button indicates that this is a fresh selection, regardless of any previous 
selections.

The Add to Selections radio button adds this particular selection to previous track selections, so that you 
may select multiple tracks for editing.



Cut

This command removes selected notes or events and places the selection in the Studio Clipboard, 
leaving a blank space. Adjacent notes or events are not affected. Use this in combination with Paste.

You can also access this command by clicking on the Cut icon in the Score View Toolbox. This icon looks 
like a pair of scissors, and lets you click and drag to select a region of music in the Score View. When you 
release the mouse button, the region will be cut.

Keyboard shortcut: Shift+Del



Copy

This command creates a copy of selected notes/events, and places the copy in the Studio Clipboard. The 
existing music is unchanged. You use this in combination with Paste.

Keyboard shortcut: Ctrl+Ins



Paste

This command places the result of a Cut or Copy command into the music at the selection point. The 
notes/events are merged into any existing music, so that no subsequent notes/events are shifted in time. 
The Paste command is not active until you have Cut or Copied a selection of notes.

You can also access this command by clicking on the Paste icon in the Score View Toolbox. This icon 
looks like a small bottle of glue, and lets you click in an area of the Score View to Paste the result of a 
previous Cut or Copy command.

Keyboard shortcut: Shift+Ins



See Also

Paste Tool



Filter System Exclusive

This option, when enabled, filters out all incoming System Exclusive (Sysex) messages.



Auto Rewind

With Auto Rewind on, the song will automatically rewind to its starting point, as soon as you click the Stop 
button in the Mixer View. The start point is most often the beginning of the song, but you can start from 
anywhere in the song, and Auto Rewind will return you there.

Keyboard shortcut: Ctrl+W



Metronome Enable

When the Metronome feature is switched on, you will hear a metronome when you are recording and    
playing your music.

The settings for the metronome are in the Setup|Metronome dialog box.

Keyboard shortcut: Ctrl+M



See

Metronome



Split Input By Middle C

When this option is switched on, any input in Record mode will be split and placed in two different tracks. 
The split point is middle C (C4).

This feature is handy for creating a piano transcription when you are playing a two-handed piece. The 
right hand (treble clef) part will be the first track, and the left hand (bass clef) part will be the second track.

Keyboard shortcut: Ctrl+B



Show Step Entry Parameters

When this option is enabled, the Step Entry Parameters dialog box 
 

will appear when you either use the Note Add Tool in the Toolbox, or use Step Record mode.



See Also

Toolbox

Step Record

Step Entry Parameters



Step Entry Parameters

If you have Show Step Entry Parameters enabled in the Options menu, this dialog box 
 

will open whenever you either enter Step Record mode, or when you use the Note Add tool in the Score 
View Toolbox (which is functionally equivalent to Step Record). You can adjust each note's duration and 
velocity values.

The Tie to Last Note choice will tie the note to the last note of the same pitch.

The Note Duration Fill group lets you choose the default length of your step-entered notes. The Staccato 
choice makes the notes shorter than usual, Legato makes the notes exactly the selected length. 
Depending on the synthesizer voice used, you may want to use more staccato notes (especially with 
sustaining voices).

The Note Velocity group lets you set the MIDI Velocity value for each note. The From MIDI choice uses 
the velocity value of an external controller. The Override Value choice lets you set the Note On and Off 
velocities (useful if you are entering notes from the Toolbox).

The Note Duration group displays the note duration you choose. For instance, if you want to enter a 
dotted quarter note, type 1 in the Quarter Note field, and 50 in the Percent field. If you are selecting note 
duration values from the Note Add palette, then the resulting numbers will be displayed.



MIDI Thru

This option lets you pass the MIDI input through to the MIDI output. This is useful for instruments that 
have Local Control off, or for separate controllers and synth modules.



Lead-In Measures

This option lets you hear a metronome count before you actually begin recording. This can help    you 
focus on the rhythmic aspect, resulting in a better take.



See

Metronome



Memory Available

This option displays the memory available to Windows in your system.

Note that the number will decrease with every additional track you record.

If you find that the number displayed is extremely low, you should save your song immediately. You will 
need to delete unused tracks, if possible, to free memory for further recording.



Follow Score View Notes

This option causes notes in the Score View to highlight as you are recording or playing back.

Note that with this option on, some operations may be slower. If you find that the system seems too slow, 
you may want to turn this option off.



Display VU Meter

This option lets you display the MIDI Note Velocity within each track in the the Mixer View.



MIDI Drivers Setup

This command opens a dialog box 

. You have three choices: Multimedia drivers, Midisoft drivers, and No drivers.

The Multimedia Drivers for Windows 3.1 option uses generic drivers written to work with any MIDI 
program that supports Windows 3.1/Multimedia Windows. You must have MIDI properly set up in the 
Windows Control Panel. Use this option if you need to use the Windows MIDI Mapper, or if you are using 
an MPC sound card (SoundBlaster, MediaVision, Ad Lib, etc.).

The Midisoft Drivers for Windows 3.0/3.1 option uses a driver created specifically for Recording 
Session. You must be using a Roland MPU-401 compatible or Midisoft Midiface interface. If you use 
these drivers, you will need to disable any standard MIDI driver settings in the Windows Control Panel. 
Note that if you choose this option, another dialog box 

 
appears that lets you set up your MIDI interface properly.

The No drivers option lets you use the program for display and editing, but not playback. This is useful if 



you have not yet purchased a MIDI interface.

The Choose MIDI Mapper Status group has four choices. For help on these choices, click on the 
Examples button.



See

MIDI Interface Settings



MIDI Interface Settings

This dialog box 

. appears when you choose the Midisoft Drivers for Windows 3.0/3.1 option in the MIDI Drivers Setup 
dialog box.

The Card Type group lets you choose either a Midisoft Midiface card, a Roland MPU-401 (or compatible) 
card, or no card.

The Interrupt Level group lets you select the proper IRQ for your card.

The I/O Address group lets you choose the proper port address.



MIDI Drivers

This dialog box 
 

appears when you first set up Recording Session.



MIDI Drivers

This dialog box 
 

appears whenever you change settings in the MIDI Interface dialog box.



See

MIDI Interface



MIDI Drivers

This dialog 
 

appears when you change MIDI Drivers.



See

MIDI Drivers Setup



Metronome Settings

This command opens a dialog box 

.

The Metronome group lets you enable (turn on) the metronome feature. You can also choose whether 
the metronome sounds in both recording and playback modes, or only recording mode.

The Sound Source group lets you choose where to send the metronome signal - to the computer 
speaker (beeps or clicks), to the MIDI interface card, or as MIDI note data to the MIDI output.

If you choose MIDI Card, you must have a Roland MPU-401 compatible interface card and be using the 
Midisoft Drivers setting in the MIDI Drivers dialog box. Your interface card must also have a Metronome 
Out jack.

If you choose MIDI Notes, the MIDI Notes Settings group becomes active. Here you choose the MIDI 
Port, the MIDI Channel, and the Pitch and Velocity of both the accented (first beat of a measure) and the 
unaccented (all others) metronome beats.

The Lead-in Measures edit field lets you enter a number of lead-in measures that Recording Session 
will count off before playing or recording.



Transcription Parameters

This command opens a dialog box 

. Here you can set how the music is displayed in the Score View. Note that this does not change any MIDI 
data.

The Note Position group controls where a note is placed. The Snap to Ruler choice causes notes to 
appear at the closest Ruler position. The Beat Tendency choice causes notes to appear at the closest 
Beat.

The Note Duration group controls the displayed duration of a note. The Lengthen choice causes notes to 
appear with a longer duration than their actual length. The Shorten choice causes notes to appear with a 
shorter duration than their actual length.

The Rest Removal group controls the amount of rests displayed The Keep All choice displays all rests. 
The Remove Many choice removes the majority of rests by lengthening adjacent notes.

Note that all three groups interact with each other.



Save Options and Setup

This command saves all settings in the Options menu, the Setup menu, and in the View menu.

Settings are written to a file named SESSION.INI, and recalled every time you start the program.



Score

This option opens the Score View 

, a view of your music in standard musical notation. You can edit your music within this window.

Keyboard shortcut: Ctrl+1



See Also

More on the Score View



MIDI List View

This option opens the MIDI List View 

, where you can see and edit your music as MIDI data.

Keyboard shortcut: Ctrl+3



See Also

More on the MIDI List View



Mixer View

This option opens the Mixer View 

, where you can change MIDI Channels, Program Changes, Volume, Velocity, and more, in real-time..

Keyboard Shortcut: Ctrl+2



See Also

More on the Mixer View



Insert New Track

Selecting this item in the Track menu opens a dialog box 
 

When this command executes, you will see a clean (empty) track between two recorded tracks.

The New Track Name field lets you assign a name to the new track.

The Insert before Track list box lets you select a location for the new track.

The Type of Staff group contains four radio buttons - Treble Clef, Bass Clef, Treble 8va (one octave 
higher), and Bass 8va (one octave lower). Choose the type of staff you want the new track to use.

The Key Signature group contains 21 radio buttons, one for each key. Choose the key you want the new 
track to use. At the bottom of the group box are two additional radio buttons - Minor and Major. The 
default is Major.

Keyboard shortcut: Ctrl+I



Delete Track

This command deletes a track, either completely (the default), or just by erasing the MIDI data in the 
track.

Selecting this item opens a dialog box 

.

The Track list box lets you choose which track to delete.

Delete Track and Contents completely erases the track and its contents.

Delete Contents Only erases the MIDI data in the track, but leaves the track intact.

(Delete Contents Only is preferred when you are re-recording a part due to a mistake.)

Keyboard shortcut: Ctrl+D



Move Track

This command moves a track to a different location. This is useful when you are trying to group tracks by 
function or timbre.

Selecting this item opens a dialog box 

.

The Move from list box. lets you choose the track to move.

The Move to list box lets you choose the destination for the moved track.

The Insert Before radio button lets you insert the track before an existing track.

The Replace radio button replaces the track with the one you are moving.



Copy Track

This command copies a track to a new location. This is useful when you want to try some editing, but 
need a backup in case things get out of hand.

Selecting this item opens a dialog box 

.

The From Track list box. is where you select the track to copy.

The To BeforeTrack list box lets you place the copied track into a particular location.



Combine Tracks

This command merges or combines two tracks into one. This is useful when you record a part in two 
sections (like a piano part)and edit/correct each individually.

Selecting this item opens a dialog box 

.

The Combine Track list box lets you select the first track you want to combine.

The With Track list box lets you select the second track you want to combine.

A Save Source Tracks check box lets you save the original tracks (before combining), in case you 
change your mind. If you switch this off, the original tracks will be deleted.



Rechannel Track

This command changes the MIDI Channel information in a track.

Selecting this item opens a dialog box 

. There are four different modes for changing MIDI Channel information:

Change All Channels to Channel X
Change Channel X to Channel Y
Extract All Events on Channel X
Separate All Channels into Tracks



Example: All events within the track are rechannelized and end up on Channel 7.



Example: All events within the track assigned to Channel 4 are rechannelized and end up on Channel 12.



Example: All events within the track assigned to Channel 5 are extracted and placed into a new track.



Example: All events within a track with Channel assignments (3, 6, and 10) are placed on three new 
tracks. The first track contains events assigned to Channel 3, the second track contains events assigned 
to Channel 6, and the third track contains events assigned to Channel 10.



Split Track by Pitch

This command lets you modify or extract MIDI data in a track based on pitch.

Selecting this item opens a dialog box 

. There are three possible modes of operation:

Change Pitch X to Pitch Y
Extract All Notes in Pitch Range
Separate All Pitches into Tracks

Note: You may enter note values as either MIDI note numbers (0 to 127), or as key numbers (C-1 to G9).



Example: All notes within the track with a pitch of D4 change to F4.



Example: All notes within the track from F2 to G5 are extracted and placed in a new track.



Example: All notes within the track are extracted by pitch number and placed in new tracks. Each track 
only contains notes of a particular pitch.



Insert Measure

This command opens a dialog box 

. You can insert one or more empty measures in all tracks. There are three edit fields for entering 
parameters.

The Insertion Point field lets you specify where to insert the new measure(s).

The Measure Count field lets you specify how many measures to insert.

The Time Signature field lets you specify the time signature of the new measure(s). The default is 4/4 
time.



Delete Measure

This command opens a dialog box 

. You can delete a particular measure (or measures) in all tracks. There are two edit fields for entering 
parameters.

The Deletion Point field lets you specify the starting measure you wish to delete.

The Measure Count field lets you specify how many measures to delete.



Change Clef

This command opens a dialog box 

. You can change the clef within a track at a specified point.

The Track list box lets you select the track.

The Type of Clef group contains four radio buttons - Treble Clef, Bass Clef, Treble 8va, and Bass 8va. 
Choose the type of clef you wish to insert.

The Insertion Point group lets you enter the location (Measure) for the inserted clef.

Keyboard shortcut: Ctrl+C



Change Time Signature

This command opens a dialog box 

. You can change the time signature for all tracks at a specified point.

The Select Time Signature group contains three radio buttons. You can select 4/4 time (the default), 2/4 
time, or you can choose the Numbers button and type in your own time signature.

The Insertion Point field lets you specify the measure where the time signature will change.

After this command, the music on the staff in the Score View will display differently (the bar lines will 
change to reflect a new time signature).

Keyboard shortcut: Ctrl+G



Change Key Signature

This command opens a dialog box 

. You can change the key signature at a specified point for a selected track.

The Track list box lets you select the track to edit.

The Insertion Point field lets you specify the location (Measure) for the key signature change.

The Accidental Count group lets you optionally enter the number of accidentals (sharps and flats) in the 
new key signature. If you have no accidentals, do not enter numbers in these fields.

The Key Signature group contains 21 radio buttons, one for each key. Choose the key you wish to use. 
At the bottom of the group box are two additional radio buttons - Minor and Major. The default is Major.

The music will not sound any different after this command, but the music on the staff in the Score View 
will display with a different amount of sharp or flat notes, depending on the key.

Keyboard shortcut: Ctrl+K



Change Tempo

This command opens a dialog box 

. You can change tempo for all tracks at a specified point.

The Begin and End groups let you specify the beginning and ending locations (Measure, Beat, and Tick) 
for the tempo change.

There are four different choices for tempo change:

Set Constant Tempo of X
Gradually Change Tempo from X to Y
Scale Tempo to X% of Current Values
Add X to Current Tempo

Keyboard shortcut: Ctrl+E



Example: The tempo is set to 144.



Example: The tempo gradually changes from 172 to 128.



Example: The tempo is scaled to 75% of 120, or 90.



Example: The tempo is 80 + 30 (110).



Scale Velocity

This command opens a dialog box 

. You can scale velocity for all notes between specified points for a selected track.

The Track list box lets you select the track.

The Begin and End groups let you specify the beginning and ending locations (Measure, Beat, and Tick) 
for the velocity change.

You have four different choices for velocity scaling:

Change All Values to X
Gradually Change Values from X to Y
Scale Values to X% of Current Values
Add X to Current Values

Keyboard shortcut: Ctrl+V



Example: The velocity is set to 75.



Example: The velocity gradually changes from 64 to 96.



Example: The velocity is scaled to 75% of 120, or 90.



Example: The velocity is 80 + 30 (110).



Transpose

This command opens a dialog box 

. You can transpose all notes between specified points for a selected track.

The Track list box lets you select the track.

The Start Point and End Point groups let you specify the region (Measure, Beat, and Tick) to transpose.

Two radio buttons let you specify whether to transpose up or down.

The Octave field lets you enter the number of octaves to transpose.

The Half-steps field lets you enter the number of half-steps (semitones) to transpose.

The Change Key Signature check box changes the key signature for the selected range you transpose.

If you try to transpose beyond the allowable range for MIDI note information, Recording Session will 
transpose as far as possible without going out of range. You then have the option of accepting this 
compromise, or cancelling the operation entirely.

Keyboard shortcut: Ctrl+T



Quantize

This command opens a dialog box 

. You can quantize all notes between specified points for a selected track.

The Track list box lets you select a track.

The Start Point and End Point groups let you specify the region (Measure, Beat, and Tick) to quantize.

The Resolution group box contains a note resolution control, quantize type check boxes, and a Precision 
scroll bar.

The Note Resolution control is a picture of a note. Click on the control with the left mouse button to 
decrease the note value. Click with the right mouse button to increase the note value.

There are three types of quantization available - changing the location of notes, changing the actual 
duration of notes, and a semi-random location quantization (Humanize). Changing location can help to 
"tighten up" rhythmic performance. Changing duration can help to make a part more consistent. 
Humanize can add a little randomness to the location and duration type quantization.

The Precision of Quantization scroll bar lets you set the degree of accuracy for the Quantize function.

Keyboard shortcut: Ctrl+Q



Contents

This command opens the Windows Help file for Recording Session at the initial Contents topic.



Help on Current View

This command opens the Windows Help file for Recording Session at the topic corresponding to your 
current window, or view.

For example, if you are in the Mixer View, and you select this command, you will go right to the Mixer 
View Help topic (without needing to find it).

Keyboard shortcut: F1



Help on Using Help

This command opens a generic Help topic describing how to use Windows Help. You may want to browse 
through this if you are unfamiliar with Windows Help.



Intro to Notation

This command opens a Windows Help topic introducing the basic concepts of musical notation.



Intro to MIDI

This command opens a Windows Help topic introducing the basic concepts of MIDI.



Help on General MIDI

This command opens a Windows Help topic introducing General MIDI.



MIDI Reset

MIDI has been in use for more than a decade. It has generated an industry, enriched many areas of 
media production, and spawned styles of music.

Nevertheless, MIDI is a complex protocol, and has been interpreted differently over the years by many 
manufacturers.

So, even though MIDI is a mature technology, you may experience one day the infamous Stuck Note (or 
notes), or some other rare anomaly.

Recording Session provides a solution for this situation. The MIDI Reset item in the Help menu opens a 
dialog box 

 
that lets you send a MIDI Reset message to your entire system. This causes any synthesizer that is stuck 
to reset to its default condition.



About Recording Session

This command opens a dialog box 
 

with information about the program.



This is a guide to the views available in Recording Session.

 
Score



 
MIDI List



 
Mixer



Score View

This view displays your music in standard musical notation form. As you record, notes will appear 
onscreen. When you play back the song, you can see the notes highlighted as they are sounding. You 
can also add, delete and edit notes and phrases from this window.

Each track is displayed on its own staff. In addition, the track name is displayed above the staff.

Along the left edge of this window is the Toolbox. There are Selection, Note Add, Note Delete, Cut, and 
Paste tools available.

Along the top of the window is a Ruler guide. This is a visual aid to help you place notes on a staff and 
select ranges of notes to edit.

The Follow Score View Notes option (Options menu) allows you to see each note highlighted as it plays 
back.

Keyboard shortcut: Ctrl+1.



Score area

Standard musical notation is a powerful and highly accurate method of communicating musical 
information. Many musicians feel comfortable with this form of language.

This area shows a notated version of the MIDI note data. You can select a note or groups of notes to 
copy, paste, or otherwise edit.



Toolbox

The Toolbox contains five icons, representing tools for working with the onscreen notation. All operations, 
except for adding notes, can be performed without the Toolbox (via the Edit menu commands).



Selection tool

This tool 
 

lets you select a note or a phrase in the Score View.

The Selection tool is the default tool. It will display highlighted, unless you have previously used a 
different tool. If so, click once on the icon to return to the Selection tool.

To select a single note, click once on the note. To select a phrase, click and hold the mouse button ahead 
of the first note in the group, drag the mouse to the last note, and release the mouse button.

Selected notes can be edited with commands from the Edit and Music menus.

You can also use this tool to change the pitch or time location of a note. Click once on the note to select it, 
and then press down on the left mouse button. While holding the button down, drag the mouse to a new 
position, then release the mouse button.

Dragging vertically changes the pitch of the note. Dragging horizontally changes the time location of the 
note.



Note Add tool

This tool 
 

lets you place notes directly on the staff without the aid of a keyboard.

Click once on the icon. The cursor changes to a note shape. A palette 

 
appears which contains note values (whole notes to sixteenth notes), sharp, flat and natural signs, and a 
dotted note symbol.

By selecting note values and other parameters in combination, you can place exactly the note you desire. 
For instance, to define a dotted eighth note you select the eighth note symbol and the dot symbol.

Place the Note Add tool on the staff where you wish to add a note. Use the Ruler along the top of the 
Score View to aid in placing the note. A vertical line will appear at the cursor position to help determine 
your proximity to a Ruler division. When you have the note in the proper position, click once with the 
mouse, and the new note will now be part of your song.

If you want to sharp or flat a note, place the note as usual, select the sharp or flat tool, then click on the 
note. If you want a double sharp or double flat, click a second time.



Notes added with this tool are always diatonic relative to the existing key signature. For example, if you 
place a note onto the staff at the position of a C, and the key signature is A major, the pitch of the note will 
be C sharp (one of the sharp notes in the key of A major).

Click once again on the Note Add palette to close it.

If you have Show Step Entry Parameters enabled (in the Options menu), a dialog box will appear that 
allows you to adjust the characteristics of the note before you place it.



Note Delete tool

This tool 
 

is the counterpart to the Note Add tool.

Click once on the Note Delete icon. The cursor changes to a note shape with a line through it. Place the 
cursor on top of the note you wish to delete. Click once and the note will be deleted, leaving an empty 
space.



Cut tool

This tool 
 

lets you select a note or phrase and cut it (for subsequent pasting).

Click once on the Cut icon. The cursor changes to a scissors shape. Place the cursor near the first note 
you wish to cut. Click and drag (keeping the left mouse button down) across the notes you want to select. 
The notes will display in reverse video.

When you have selected all the notes, release the mouse button. The selected notes will be cut out of the 
music and copied to the Clipboard. (The cursor will automatically change to a paste bottle shape, 
signifying that there is note data ready for a Paste operation.)



Paste tool

This tool 
 

lets you paste a note or phrase that you have previously copied or cut.

Click once on the Paste icon. The cursor changes to a paste bottle shape. Place the cursor on the staff at 
the location you want to paste the music. Click once and the note data stored in the Clipboard will be 
copied into the the staff.

You may repeat the Paste operation as many times as you wish, until you perform a Cut or Copy 
operation (which places new data in the Clipboard, overwriting previous data).



Ruler

You use the Ruler to visually guide the selection or placement of notes. When you are placing a note 
(using the Note Add tool), the Ruler divisions will appear as long vertical lines as you place the cursor on 
a note boundary.

The resolution of the Ruler is sixteenth note divisions.



MIDI List View

This view lets you see the MIDI data as actual MIDI messages. If you are comfortable with a traditional 
MIDI sequencer, this gives you the flexibility of minute adjustments to the shape of each note. In addition, 
you can enter and edit MIDI messages such as Program Change, Aftertouch, Pitch Bend and others.

The MIDI List View displays the MIDI data for a particular track. You can look at all note events, as well as 
Program Change commands and various controller and volume events, in the order that they occur.

You can also edit the Tempo track for the sequence. When you select this track, the parameters are Type, 
Duration, Absolute Tempo, and Scaled Tempo.

Keyboard shortcut: Ctrl+3



Type

Type refers to the MIDI event type. For example, it will display ProgChng for a Program Change 
message, Note for a Note event, etc. You can change the parameters by clicking in the columns to the 
right, or you can select the event by clicking within the Type column.



Channel

Channel indicates the MIDI Channel assignment for the event. You can change the Channel for an event 
by clicking with the left or right mouse button to decrease or increase the Channel number.

You can rechannelize all events within the track with the Rechannel command in the Track menu.



Start Time

Start Time is the point in the file where the event begins.



Duration/Data

Duration/Data displays either the duration of the event (for Note events), or the Data value (for all other 
events).



Pitch

Pitch displays the Note number of the Note event. This is blank for other event types.



Delete MIDI Event button

Clicking on Delete will delete the currently selected event within the MIDI List View. If no event is 
selected, nothing will be deleted.



Track list box

At the top of the MIDI List View window is a list box for choosing the track to display. If you have 
previously edited or altered a track, it will be the track displayed. Change the track if necessary by clicking 
on the arrow to the right of the list box. A list will drop down, and you can double-click on the correct track.



Velocity On and Velocity Off

Velocity On and Velocity Off display velocity values for Note events. These are blank for other event 
types.



Insert MIDI Event

This dialog box lets you insert one of six MIDI event types.

Click on an event type for more information.



Insert Note

This dialog box 
 

lets you insert a MIDI note event at any point in the selected track.

The Pitch field lets you set the pitch either with a MIDI note number (e.g. 48) or a pitch number (e.g. C4).

The Channel field lets you set the MIDI Channel assignment for the note.

You can set the Start point and Duration in Measure, Beat, and Tick increments.

The Velocity fields let you set the Note On and Note off velocities.



Insert Channel Aftertouch

This dialog box 
 

lets you insert a Channel Aftertouch message at any point in the selected track.

The Channel field lets you set the MIDI Channel assignment for the message.

The Time field lets you place the message at a particular location.

The Value field lets you set the amount of Aftertouch.



Insert Key Aftertouch

This dialog box 
 

lets you insert a Key Aftertouch message at any point in the selected track.

The Pitch field lets you set the particular pitch the aftertouch message will affect.

The Channel field lets you set the MIDI Channel assignment for the message.

The Time field lets you place the message at a particular location.

The Value field lets you set the amount of Aftertouch.



Insert Controller

This dialog box 
 

lets you insert a MIDI Controller message at any point in the selected track.

The Type field lets you enter the Controller number (e.g. 7 for MIDI Volume).

The Channel field lets you set the MIDI Channel assignment for the message.

The Time field lets you place the message at a particular location.

The Value field lets you set the amount of the particular Controller.



Insert Program Change

This dialog box 
 

lets you insert a Program Change message at any point within the selected track.

The Channel field lets you set the MIDI Channel assignment for the message.

The Time field lets you place the message at a particular location.

The Value field lets you set the number of the Program Change message.



Insert Pitch Bend

This dialog box 
 

lets you insert a Pitch Bend message at any point within the selected track.

The Channel field lets you set the MIDI Channel assignment for the message.

The Time field lets you place the message at a particular location.

The Value field lets you set the number of the Pitch Bend message.



Insert Tempo Change

Within this dialog box 

, you can specify the Base Tempo (the absolute tempo in the Tempo Track), the Adjusted Value (the 
scaled value), and the location in the track.

The two tempo values have a direct relationship to the Tempo slider in the Mixer View. The Adjusted value 
is the Base Tempo multiplied by the Tempo box scroll bar.

For example, if the Tempo scroll bar was set at 100%, and you entered a value of 124 in the Base Tempo 
field, the Adjusted Tempo value would display 124. If the Tempo scroll bar was set at 50%, and you 
entered a value of 124, the Adjusted Tempo value would be 62.



Mixer View

This view is constructed like a traditional mixing board and tape deck system. Within this view you record 
and play back MIDI music, solo or mute individual tracks, name and route tracks, and adjust volume and 
velocity.

Keyboard shortcut: Ctrl+2



Track Module

Each track has a track module associated with it. You can control numerous real-time sound parameters 
for each track from this module. You also can mute, solo, or enable record mode for each track. There is a 
level display meter for each track.



Track Number and Name

Each track has a Track number and name at the bottom of each Track module.This can be a useful aid in 
remembering which track is which. (This is in case you name your seventh, sixteenth, twenty-first, and 
thirty-second tracks HORN SOLO.) The number is permanently associated with a particular track. The 
name can be entered in the Track Settings dialog box.



See

Track Settings



Program Change Number/Name

Each track has a Program Change number and Name above the Track Name. This will display any 
Program Change messages within the track as either numbers, or as General MIDI names.

When you click on the number or name, the Track Settings dialog box appears. You can rechannelize the 
MIDI data within the track, enter a meaningful name for the track, switch on or off MIDI Bank Select and 
General MIDI Names, and choose a Program Change number (or patch name) for the track.



See

Track Settings



Track Loudness

The Loudness control allows you to temporarily adjust Velocity for the track. (Most MIDI devices respond 
to this, although there are a few that do not -- check your device's documentation.)



VU meter

At the top of the Track module is the VU Meter. If you have this enabled, you will see a display of the 
velocity present in that particular track, while the music plays.

The Display VU Meter option turns this on or off.



See

Display VU Meter



Chorus/Reverb/Pan controls

These controls adjust the levels of Chorus, Reverb, or Panning on MIDI instruments that support these 
capabilities. If your instrument does not support Chorus, Reverb, or Panning, the controls have no effect.



Track Mute button

This button enables the Muting (turning off) of a particular track. When the button is depressed (by 
clicking once with the mouse), it will be highlighted. Click a second time on the button to turn off Muting.



Track Solo button

This button enables the Solo function for a particular track. When the button is depressed (by clicking 
once with the mouse), it will be highlighted.    All other tracks will be muted, and only the track(s) with the 
Solo button on will play. Click a second time on the button to turn off Soloing.



Track Record button

This button enables the Record function for a particular track. This is used when you want to override the 
default recording track, which is always the next available (empty) track. You would use this when 
overdubbing new material onto a previously recorded track.

Only one track can be in Record mode at a time. If you try to depress more than one button, only the last 
one selected will highlight, and any others will turn off.

The exception to this is when you use the Split Input By feature (Setup|Preferences)to split the incoming 
MIDI data by pitch, Channel, or both.



Master Module

The Master Module contains a Counter display, a Master Volume control, a Master Chorus control, a 
Master Reverb control, and a Tempo slider.



Counter display

At the top of the Master module is the Counter display. This displays the current song location in 
measures, beats and ticks. One measure of 4/4 time contains 4 beats. One beat contains 96 clock ticks.



Master Volume control

This controls the overall loudness of all the tracks.



Master Chorus/Reverb controls

This controls the amount of Chorus and Reverb, respectively, that is applied to all tracks. If your MIDI 
instrument does not support Chorus or Reverb, these controls will have no effect.



Tempo control

The Tempo control is below the Counter display. You can increase or decrease the tempo by using the 
slider. The current tempo and the scaling percentage is displayed below the slider.

The slider actually scales the Tempo Track for the entire sequence. Any changes you make with this 
control will be saved to disk when you save the song file. To return the tempo to its default setting (so that 
you do not save tempo changes), drag the slider until the scaling percentage returns to 100%.



Tape Deck buttons

Beneath the Master module are the Tape Deck buttons. You can activate these by clicking on them with 
the left mouse button.

You can also use the Spacebar to toggle between Play and Stop.



Stop Button

Click on this control with the left mouse button to stop a song while playing, recording, rewinding, or fast 
forwarding.

Pressing the F2 key on the computer keyboard has the same effect.



Play Button

Click on this control with the left mouse button to begin playing a song.

Pressing the F5 key on the computer keyboard has the same effect.



Record Button

Click on this control with the left mouse button to begin recording a track. The first available track will shift 
into Record mode.

Pressing the F6 key on the computer keyboard has the same effect.



Rewind Button

Click on this control with the left mouse button to rewind a song. Click with the right mouse button to 
rewind a song automatically to the beginning.

Pressing the F3 key on the computer keyboard has the same effect.



Fast Forward (FF) Button

Click on this control with the left mouse button to fast forward within a song.

Pressing the F4 key on the computer keyboard has the same effect.

You can press this button while playing back a song and the playback tempo will speed up. Pressing once 
again will return playback speed to normal.



Pause Button

Click on this control with the left mouse button to pause a song while playing, rewinding, or fast 
forwarding. Click a second time to resume the paused operation.

Pressing the F7 key on the computer keyboard has the same effect.



Step Button

Click on this control to shift to Step Mode. In this mode, the Record and Play buttons control the Step 
Record and Step Play operations.

You can also use the computer keyboard to control Step Record and Step Play. The F8 key controls Step 
Record, and the F9 key controls Step Play.



See Also

Step Entry Parameters

Step Record and Step Play



Track Settings

This dialog box 
 

appears when you click on the Track Name/Number fields in the Mixer View for a particular Track.

The Instrument list box lets you choose a Program Change number or General MIDI Instrument Name.

The Output Assignment group lets you choose the MIDI Port and MIDI Channel.

The Bank Number field lets you choose a Bank Number if your synthesizer responds to Bank Change 
messages.

The Use GS Bank Select and Use General MIDI Names let you use the Roland Bank Select protocol (if 
you have a compatible piece of Roland equipment) and General MIDI names instead of standard 
Program Change numbers.

The Description field lets you enter your own descriptive name for your track.



Recording Session is a powerful sequencer offering standard MIDI sequencing features, as well as an 
editable musical notation display.

The program contains three windows, or views that you use to record, play, and edit your musical 
compositions.

 
Score View



 
MIDI List View



 
Mixer View



Score View

This window displays your music in standard musical notation. As you record, notes will appear onscreen. 
When you play back the song, you can see the notes highlighted as they are sounding. You can also add, 
delete and edit notes and phrases from this window.



See

More on the Score View



Mixer View

This window is where you record, play, name and adjust tracks. You have real-time control of the 
playback characteristics of each track, so you can experiment before making permanent changes.

This window contains transport buttons that resemble an audio tape deck, as well as a tempo slider, a 
Master Volume control, and a song location display (Counter).



See

More on the Mixer View



MIDI List View

This window displays your music as MIDI events. If you are more comfortable with a traditional MIDI 
sequencer, this affords you the flexibility of minute adjustments to the shape of each note. In addition, you 
can enter and edit MIDI messages such as Program Change, Aftertouch, Pitch Bend and others.



See

More on the MIDI List View



This is a reference to the menu comands, tools, preferences, keyboard shortcuts, and terminology within 
Recording Session.

 
Menus



 
Tools



 
Preferences



 
Keyboard shortcuts



 
Glossary



Preferences

You can adjust and customize many aspects of Recording Session. You can then save these 
adjustments, so you always return to the program with the same settings.

The Options menu includes features of the program that you can switch on and off, often within the same 
session.

The Setup menu includes settings that you may want to specify once, and store for later use in many 
sessions.



See

Option menu commands

Setup menu commands

Saving your settings



Saving your settings

There are two files that store settings in Recording Session.

SESSION.INI stores all of the Option menu item settings, all of the Setup menu item settings, the song 
directory, and the default song file type.

MIDISOFT.INI stores the positions of the Views, the screen resolution, and the MIDI port settings.

To save all these various preferences, choose Save Options and Setup from the Setup menu.



Keyboard shortcuts

Spacebar Play/Stop toggle

F1 Help on Current View

F2 Stop button

F3 Rewind button

F4 Fast Forward (FF) button

F5 Play button

F6 Record button

F7 Pause button

F8 Step Record

F9 Step Play

Alt or F10 Activate menu bar

Shift+Del (Edit) Cut

Shift+Ins (Edit) Paste

Ctrl+Ins (Edit) Copy

Ctrl+F1 (Help) MIDI Reset

Ctrl+1 (View) Score

Ctrl+2 (View) Mixer

Ctrl+3 (View) MIDI List

Ctrl+A (Edit) Select All

Ctrl+B (Options)Split Input by Middle C

Ctrl+C (Music) Clef

Ctrl+D (Track) Delete

Ctrl+E (Music) Tempo

Ctrl+G (Music) Time Signature

Ctrl+I (Track) Insert

Ctrl+K (Music) Key Signature

Ctrl+M (Options) Metronome Enable

Ctrl+N (File) New

Ctrl+O (File) Open

Ctrl+Q (Music) Quantize

Ctrl+S (File) Save

Ctrl+T (Music) Transpose

Ctrl+V (Music) Velocity

Ctrl+W (Options) Auto Rewind

Ctrl+X (File) Exit

Alt+Backspace (Edit) Undo

Alt+F File menu

Alt+E Edit menu



Alt+O Options menu

Alt+S Setup menu

Alt+V View menu

Alt+T Track menu

Alt+M Music menu

Alt+H Help menu



This is a reference to the most common procedures within Recording Session.

 
Playback and Recording



 
Editing



 
Advanced Procedures



Playback and Recording

Opening a song Saving a song

Recording Playback

Overdubbing Entering Notes in Score View



Editing

Selection Basic editing

Track editing Region editing

MIDI List editing



Advanced Procedures

Step Record and Step Play

Auto Play



Opening a song

Choose the Open command from the File menu. A dialog box will appear 

.

The File Types list box lets you choose the file format: Midisoft Studio or Standard MIDI File format.

Depending on the file format, the files listed will all have an SNG extension (Studio file) or MID extension 
(Standard MIDI File).

If the song you wish to load is in a different directory or on a different disk drive, use the Directories list 
box or Drives list boxes to find the song.

Select the song file you want to open by clicking on it with the mouse. Click the OK button to load the 
song into memory.



Saving a song

You may have recorded a track (or two, or five) and now wish to save the music with a meaningful name 
for a later date. Click on the Save command in the File menu. If you have not yet saved the data, you will 
automatically open up the File Save As dialog box 

. Otherwise, the song will be saved to disk.

The File Name text box allows you to type in the name you want for the song. We recommend that you 
choose a name that you will still remember in two weeks.

A File Type list box lets you choose the file format: Midisoft Studio,    Standard MIDI File format 0, or 
Standard MIDI File format 1.

To change the directory, double-click on the directory name in the Directories list box. If you need to move 
backwards (closer to the root directory), move your selection up one directory and double-click.

To change the drive, click on the drive name in the Drives list box.

When you have made all your choices, click on the OK button and your song will be saved to disk.



Recording

To record a song file, first clear the memory by choosing the File|New command (in the File menu). This 
clears the memory and sets you up with the equivalent of a blank canvas. (You can use the computer 
keyboard shortcut Ctrl+N.)

Make sure the Mixer View is open. If not, choose the proper item from the View menu. Or, if you prefer, 
use Ctrl+2. You can use the Score View (Ctrl+1) and the MIDI List View (Ctrl+3), but it is not necessary.

Click on the Record button in the Mixer View, and the metronome will start to tick. Assuming that you have 
your MIDI instrument connected correctly, you are ready to record. 

Play a simple part, such as a bass line or chords -- remember that you can play each part of your music 
separately. When you are done, click on the Stop button (also in the Mixer View).

Click in the Track Name field for the track you have recorded to assign a name to it. A dialog box 
 

will open up that allows you to name the track, rechannelize the MIDI data, and assign a Program 
Change number to the track.

If for some reason you want to redo completely the part you just recorded, you can choose Delete from 
the Track menu. You will see a dialog box with a list of tracks. Select the correct track and click OK to 
erase the track.

An alternate method is to select the File|New command. Be aware that using this method clears 
everything, so only use this when you truly want to start over with a blank canvas.

When you have recorded the part, the Score View (if it is open) will show the music in notation form. Each 
part (or track) that you add will display on a different staff.



Playback

Click on the Play button in the Mixer View. The button will be highlighted (the symbol displays in a 
different color). The music plays back, with an optional lead-in measure and a metronome beat (if 
enabled).

As the music plays, the Counter display will display the present location within the song. If you have 
Follow Score View Notes enabled, you will see the notes highlighted onscreen as they play back.

You can adjust the tempo of the song as it is playing. Click and drag the Tempo slider to the left to 
decrease the tempo. Click and drag to the right to increase the tempo.

To stop the song, click on the Stop button. The button becomes highlighted momentarily and the music 
stops. (The Play button returns to the normal inactive color.)

If you have Auto Rewind enabled, the song will rewind to whatever location you started from when you 
click on the Stop button to halt playback.

You can set the Auto Rewind starting point on the fly. While you are playing a song, click on the Play 
button. This will mark the location for the Auto Rewind function.

Pressing the Space bar (on the computer keyboard) will toggle, or switch, between Play and Stop.



Overdubbing

The process of recording new tracks in synchronization with previously recorded material is called 
overdubbing.

Overdubbing revolutionized the recording industry, by allowing recordings to be made over a period of 
time, rather than at one particular moment. Musical pieces could be built up part by part. A single 
musician could even play all the parts!

In the same way, overdubbing is one of the most powerful features of a MIDI sequencer.

Click on the Record button in the Mixer View to begin recording. The next available clean (empty) track 
will switch into Record mode.

You will hear the metronome, if enabled, and the song will begin. You can listen to the previously recorded 
part(s) playing so you can match the new part with it. When you are done, click on the Stop button.



Entering notes in the Score View

Click once on the Note Add tool 
 

in the Toolbox. The Note Add tool becomes highlighted. A palette of note values and tools opens up.

The cursor changes from a pointer to a note shape. The note shape reflects the note value that you select 
from the Note Add palette. The default is a quarter note.

When you move the cursor over the staff, a line will appear when you are lined up with the Ruler. This is 
relative to the note value you choose. For instance, with a quarter note, the line will appear when you are 
lined up with the quarter note markings on the Ruler. This can help you place a note with greater 
precision.

Use the Ruler to guide the cursor as you are placing the note. When you have the cursor in the correct 
place, click once and the note will be placed on the staff.

Remember that notes placed this way are diatonic relative to the current key signature. For instance, if 
you place a note into the C location on the staff, and the key signature is A major, the note will actually be 
a C sharp (one of the three sharps in the key of A major).



See Also

Tools



Selection

To edit your music with Recording Session, you need to select the part(s) to be edited. This can be done 
in various ways, depending on which part of the program you are in at the time.

Score View selection MIDI List selection

Dialog box selection Edit menu selection



Selecting in Score View

In the Score View, clicking on a note selects it. Clicking within the window (but not on any note) deselects 
the note.

If you wish to select multiple notes, hold down the Ctrl key while clicking on the additional notes. The 
notes do not need to be contiguous. To deselect a note, click a second time (still holding the Ctrl key).

You can also select multiple contiguous notes by clicking and dragging. Click and hold down the left 
mouse button when the mouse cursor is next to the first note in a group. (Make sure you are not on top of 
a note, or you will only select that note.) Drag the mouse, still holding down the mouse button, until you 
pass the last note in the group. Release the mouse button. The group will display in a highlighted color (or 
reverse video ) to indicate that it has been selected.

Once you have made your note selection, you can choose the editing operation from the Edit or Music 
menus.



Selecting in MIDI List View

This view is similar to the Score View. You can select single events, multiple events, and groups of events 
with the same clicking and Ctrl-clicking techniques described earlier.



Selecting in dialog boxes

Some editing operations (Quantize, Scale Velocity, Transpose, and Change Tempo) allow you to select a 
region from within their associated dialog box.

The selection is accomplished by entering values for Measure, Beat, and Tick starting and ending points.

By default, the last value used is automatically entered in the appropriate dialog box. This saves time 
when you are applying multiple edit operations to the same region of music.



Edit menu selection

There are three selection comands in the Edit menu.

Select All Select Measures

Select Tracks



Basic editing

The basic editing operations can be found in the Edit menu. These include Cut, Copy, and Paste. All of 
these use the Studio Clipboard.

The Studio Clipboard is a temporary storage space for MIDI note and event information. The Cut and 
Copy commands place information into the Studio Clipboard area, while the Paste command retrieves 
previously stored information from the Studio Clipboard.

As the Studio Clipboard is only a temporary storage area, any information in it will be overwritten by a 
new Cut or Copy command.

The Cut and Copy commands will place a bitmap copy of selected notation within the Score View into the 
Windows Clipboard. You may then paste this into a word processing document in another application. 
Note that the selection must fit in the Score View window, and the notes must be black on a white 
background, in order for this to work.

Cut

Copy

Paste



Track editing

Often you may want to change a characteristic of an entire track, rather than a smaller area such as a 
measure. The track editing commands are in the Track menu.



See

Track menu commands



Region editing

There are some editing commands that operate on a selected region of music. These editing features are 
located in the Music Menu.



See

Music menu commands



MIDI List editing

At the top of this view is a list box for choosing the track to display. If you have previously edited or altered 
a track, it will be the track displayed. Change the track if necessary by clicking on the arrow to the right of 
the list box. A list will drop down, and you can click on the correct track.

There are two track types - the typical track with MIDI note data, and a Tempo track. A song may have 
many regular tracks, but it will only have one Tempo track.
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Editing a regular track

The fields within the MIDI List View include Type, Channel, Start Time, Duration/Data, Pitch, Velocity On, 
and Velocity Off.

You can change values by clicking on them with the mouse. If you use the left mouse button, the value 
will decrease, and if you use the right mouse button, the value will increase.

The Type field displays the MIDI event type. For example, it will display ProgChng for a Program Change 
message, Note for a Note event, etc. You can select the event by clicking within the Type column. You 
cannot change this field.

The Channel field displays the MIDI Channel assignment for the event.

The Start Time field displays the point in the file where the event begins. The Measure, Beat, and Tick 
values are displayed. Click within the column for the value you wish to change.

The Duration/Data field displays either the duration of the event (for Note events) or the Data value (for all 
other events). You can change this parameter by clicking within the column.

The Pitch field displays the Note number of the Note event. (This is blank for other event types.) Click 
within the column to change the pitch.

The Pitch value is displayed as a letter with a number after it (e.g. C5). The MIDI specification allows 128 
different pitches, from C-1 (a C five octaves below middle C) to G9 (a G five and a half octaves above 
middle C).

The Velocity On and Velocity Off fields display velocity values for Note events. Click within the respective 
columns to change velocity. (These are blank for other event types.)

There are two buttons in the upper right corner - Insert and Delete.

Clicking on Delete will delete the currently selected event within the MIDI List View. If no event is 
selected, nothing will be deleted.

Clicking on Insert will open a dialog box with a choice of MIDI event types. The event you choose will be 
inserted before the currently selected event within the MIDI List View.

The event types available are Note Event, Program Change, Channel Aftertouch, Key Aftertouch, 
Controller, and Pitch Bend.



See

Inserting a MIDI Event



Editing the Tempo track

If you choose the Tempo track in the Track list box, the display in the MIDI List View is somewhat 
different. This is because the Tempo track is a special type of track that only stores tempo changes.

The fields within this window include Type, Time, Absolute Tempo, and Scaled Tempo.

TheType field always displays Tempo Change when working with the Tempo track.

The Time field displays the location in time (measure, beat, and tick) of the Tempo Change event. You can 
edit these values by clicking with the mouse. The right mouse button increases, and the left mouse button 
decreases the value.

The Absolute Tempo field displays the absolute tempo value stored within the Tempo track. This value 
multiplied times the scaling percentage equals the Scaled Tempo. The scaling percentage is controlled 
interactively by the Tempo slider in the Mixer View and the Tape Deck View.

The Scaled Tempo field displays the scaled tempo value. This value is always equal to the absolute 
(base) tempo in the Tempo track multiplied by the scaling percentage.

There are two buttons in the upper right corner - Insert and Delete.

Clicking on Delete will delete the currently selected Tempo Change event within the MIDI List View. If no 
event is selected, nothing will be deleted.

Clicking on Insert will open the Tempo Change dialog box 

.



See

Inserting a Tempo Change event



Tempo Change

Within this dialog box

, you can specify the Base Tempo (the absolute tempo in the Tempo Track), the Adjusted Value (the 
scaled value), and the location in the track.

The two tempo values have a direct relationship to the scroll bar in the Tempo Box. The Adjusted value is 
the Base Tempo multiplied by the Tempo box scroll bar.

For example, if the Tempo scroll bar was set at 100%, and you entered a value of 124 in the Base Tempo 
field, the Adjusted Tempo value would display 124. If the Tempo scroll bar was set at 50%, and you 
entered a value of 124, the Adjusted Tempo value would be 62.



Step Record and Step Play

Step recording is a method for entering notes one at a time. It is slower than real-time recording, but the 
advantage is that you gain precise control over each note. This method is ideal if you do not have good 
enough keyboard skills to play a part from start to finish. It allows you to go at your own pace, slowing 
down for the difficult sections.

Step play is a mode for stepping through your MIDI music one event at a time. This is useful when you 
have a dense passage of music, and you want to isolate a note or a phrase. It is also helpful when you 
are setting the Punch-in values.

You enter Step mode in the Mixer View.



See
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Step Record

Click on the Step button in the Mixer View. The button highlights, indicating that the program is now in 
Step Mode. Next, click on the Record button. The Toolbox in the Score View opens up, allowing you to 
choose note values. If you have Show Step Entry Parameters enabled in the Options menu, the Step 
Entry Parameters dialog box 

 
will pop up. This box contains settings for note duration and velocity.

If you have a MIDI keyboard or other controller connected, simply play each note. To change the value of 
each note, enter the new value in the Step Entry Parameters dialog box, or choose the proper value by 
clicking on the Note Add palette icons.

When you place notes in the Score View using the Note Add tool, you are actually step recording. This is 
a very slow method of entering music, but very handy for short phrases and the occasional extra note.

Step Record only records note data (Note On/Off, Velocity) and Program Change messages. All other 
MIDI data, including Aftertouch, Pitch Bend, and System Exclusive messages, are ignored.

To leave Step Mode, click once again on the Step button. The button will return to its normal color, and 
the Record and Play buttons will return to their usual states.

Keyboard shortcut: F8
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Note Add tool



Step Play

Click on the Step button in the Mixer View. The button highlights, indicating that the program is now in 
Step Mode. As you click on the Play button, the song will move forward by one note event. Each time you 
click on Play, the next note event will play.

Use this when you want to step through a difficult passage and locate a particular note.

To leave Step Mode, click once again on the Step button. The button will return to its normal color.

Keyboard shortcut: F9



Auto Play

When you start Recording Session, the program looks for a file called SONGLIST.TXT in the song 
directory. This file is a list of songs in the order you want them to play.

If the file exists, you will see a dialog box 

, asking if you want to to run Auto Play. If you click on OK, the first song on the list will play. When it ends, 
the next song will play, and so on, until the final song plays and ends. At this point, the cycle will begin 
again.

This feature was designed with live performance in mind. You can create a list of songs, and play each 
song in turn, without having to load any files from disk.

You can temporarily stop the process at any time by clicking on the Stop or Pause button.

To stop Auto Play completely, choose either the New command or the Open command in the File menu.

Each song named in the SONGLIST.TXT file must actually be present in the song directory, or else the 
Auto Play mode will end.

You may want to put one or two lead-in measures before each song, especially if you have a fast hard 
disk. Otherwise, you may start the next song before the applause dies down!
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Creating a song list

The SONGLIST.TXT file is an ASCII text file. This is the simplest kind of file, one that virtually all word 
processing programs can produce.

To create the file, start a new document in your favorite word processor. Type the name of the song 
(including the SNG or MID extension). Each song must be on its own line, followed by a carriage return. 
Do not type in the pathname.

When you save the file, the format you choose will probably be called ASCII or Text Only. (If you do not 
save in this format, Recording Session cannot recognize the file.) Remember to save the file with the 
name SONGLIST.TXT.

The Notepad and Windows Write programs that come with Windows are both able to save in ASCII 
format.



Setting the song directory

If the songs are in a different directory than the program, you can set this and store it as a preference.

Open a file from this directory. Choose the Save Options and Setup command in the Setup menu. The 
directory is now saved as your song directory, and is where Recording Session will look for song files 
and for the SONGLIST.TXT file.




